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Introduction. 
 
Universal Design for Learning is an approach which focuses on creating accessible documents 
for all types of learners.  The approach is especially helpful for learners with visual, cognitive, 
auditory, and mobility dysfunctions.  When developing documents to create greater accessibility 
each type of learner must be considered.  More specifically:  

• Visual.  These learners include blind, low vision, and color-blind individuals.  Blind 
and low-vision learners will often use screen reading software (often referred to as 
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screen readers) which requires certain kinds of punctuation and navigation 
formatting.  Color-blind accessibility includes limited use of color for communicating 
information. 

• Cognitive.  These learners include learning disabled, traumatic brain injured, and 
other forms of impairment which affect information processing.  Those with cognitive 
impairments may use screen reading software, but even those who do not will benefit 
from increased ease of navigation functionality.  Concise, uncluttered, low noise 
document formatting increases comprehension and reduces distractions. 

• Auditory.  These learners include individuals who are deaf or hard of hearing.  
Documents with links to websites or require any sound as part of the communication 
of information must be captioned. 

• Mobility.  These learners include individuals who have restricted or no mouse or 
keyboard mobility or capability.  These learners require navigation formatting which 
provide simple limited steps for locating information in the document.  They may or 
may not be using screen reading software.   

 
Accessible documents have a variety of formatting functions regardless of purpose:   

• Templates. 
• Headings. 
• Numbered lists. 
• Tables. 
• Captions for objects and media links. 
• Alt-tags for objects and images. 
• Special Punctuation. 
• Concise Phrasing. 

Template. 
 
A Template is a format and styles document attached to your document.  Every time you open a 
new document, you will automatically open the “normal” template developed by Microsoft.  For 
MS Word you can make your own document template which can include the formatting needed 
for accessibility.  For PowerPoint you will need to choose a design template which is preset for 
accessibility. 

Headings. 
 
Whenever you develop a new section or idea in a document, you need to label it using Headings.  
This allows for screen readers to read sections of a document rather than having to read the entire 
document.  You can also navigate within your document to different sections if you have 
developed Headings using the Document Map feature.  It also allows for creating a Table of 
Contents for the document that is linked to the headings.   
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Numbered Lists. 
 
The Bullet/Numbering formatting function needs to be used for all listed information.  Numbered 
lists should be used when the list has a rank order or sequential steps.  Bullets can be used for 
other lists.   

Tables. 
 
Information listed in columns should be formatted using the Table function.  In a new document, 
this can be done by using the Draw Table command.  In an existing document, the text 
information can be converted to a table of information by using the Convert command. 

Captions For Objects And Media Links. 
 
Media files and hyperlinks should be used only when they can illustrate or enhance a message.  
Images and objects should not be added to a document as decorative or gratuitous.  If the media 
or links are clearly useful, then they must be made accessible.  Visual information must be 
described completely using captions and audio must include a complete transcript of the text.  
Audio-video clips must be captioned so that the text is visible as the video is playing.  In 
addition, hyperlinks included in the document text are confusing, complicated, and often fail to 
be accessible.  Although faculty and students may have access to the Internet from the 
classroom, depending on hyperlinks is risky.  Connection failures, control over fonts, noises, 
readability, and more are frequent problems which interfere in creating coherence and 
understanding.  Such links should be reviewed for accessibility prior to using them to present 
evidence or examples.   

• Video must be described completely in alternative text (Alt-Text). 
• Audio must have a text transcript. 
• Multimedia must be captioned. 
• Links to Websites (referred to as hyperlinks) should be used only if Website is 

already accessible. 

Special Punctuation. 
 
Punctuation is an important component for maintaining coherence for both the physically and 
programmatically disabled learners.   

• Capitalize first letter of bulleted and numbered lists, headings, and sentences. 
Capitalization indicates the beginning of a new phrase or thought.   

• Use periods at the end of each phrase/sentence.  This includes headings, items in 
bullets/numbered. The use of periods at the end of each phrase creates visual 
benchmarks for ending a thought.  For screen reading software, the period indicates 
the end of a phrase.   

• Do not abbreviate. Abbreviations should never be used because not only are screen 
readers unable to process the abbreviation, learners with visual, auditory, and 
cognitive impairments will not necessarily understand what the abbreviation means. 
Remember, spell checkers do not always catch misspelled words or abbreviations, 
especially in titles. 
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• Do not use contractions.  Contractions can also create word confusion.   
• Use acronyms only after defining them.   

Concise Phrasing and Style. 
 

• Remove clutter.  Keep document neat and orderly. 
• Avoid long quotes or paragraphs of text.  
• Use an average of 5-6 words per line per bullet or numbered list, avoid wrapping text 

whenever possible. 
• Use no more than 3 or 4 lines per bullet or numbered list whenever possible. 
• Limit use of color (e.g., fonts, backgrounds). If used, do not use blue, red, and green; 

learners with visual or cognitive dysfunctions have more problems with these colors. 
• Bolding, italicizing, and underlining does not get read by screen readers and should 

not be used for conveying information or emphasis. 
• Avoid symbols and pictures.  If pictures are necessary, they must be captioned and 

Alt-tagged. 

Converting an Existing Syllabus Document to an Accessible Document. 
 
Students with visual impairments or disabilities rely on documents being read.  This is done 
using various screen readers.  These computer applications can only read the document in its 
entirety unless it is developed with headings.  With headings, the computer program can read the 
headings and the student can pick the appropriate section he/she wants read.  Use the following 
steps to change an already written syllabus to include headings: 

STEP 1:  Preparing the document for conversion.   
 

a. Open the document you want to convert. 
b. Save the document under a new filename. 

STEP 2:  Locating Styles and Formatting Task Pane.   
 

a. Click on the Format drop menu. 
b. Select Styles and Formatting. 
c. A Styles and Formatting task pane will appear on the right hand side of screen listing all 

formatting currently in the document (See Figure 1). 
d. At the bottom of new task pane, there is a dialogue box (menu under show), make sure 

this says Available formatting 
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Figure 1:  Styles and Formatting Task Pane. 

 

STEP 3:  Preparing Document. 
 
There are several ways to remove the style formatting from the document to get a fresh 
document.  The easiest way would be to take the following steps: 

a. Select all text in the document window (control A). 
b. In the Styles and Formatting task pane, click on Clear Formatting. This clears all current 

visible formatting in the document but does not delete the formatting from the document 
template attached.   

c. In the document window, select all text. 
d. Copy all text. 
e. Open a new document and paste the text.   
f. Open the Styles and Formatting task pane (see Step 2).  You will notice that in the Styles 

and Formatting text pane that there is now a limited amount of formatting.  Importantly, 
you should see Heading 1, Heading 2, and Heading 3. (See Figure 2)  
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Figure 2: Styles and Formatting Task Pane with Limited Formatting. 

STEP 4:  Format Headings. 
 
You now need to format all of your headings.  You can have different levels of heading.  For 
instance, Heading 1 may be capitalized, center, and bolded.  Heading 2 may be left justified and 
capitalized.  The number of headings will depend on your document needs. 

a. Make sure that no text is selected in your document.  Then, to format a heading, select 
Heading 1 in the Styles and Document task pane.  The paragraph symbol will change to 
an arrowhead which allows you to open a drop down menu (See Figure 3). 
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Figure 3:  Task Pane Demonstrating Selection of Heading 1. 

 
b. Select Modify.  A box will open titled Modify Style (See Figure 4). 
c. Now modify your formatting.  This will most often be done by clicking on the Format 

box in the bottom left hand corner (See Figure 4) which provides options for such 
functions as Font and Paragraph. 
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Figure 4:  Modify Style Dialog Box. 

STEP 5:  Applying Headings to Your Document.   
 
To change the format of text in your document, you need to apply the style from the Styles and 
Formatting task pane. 

a. Select the text you wish to change.   
b. Choose a style by placing the mouse curser on the style in the task pane.  In the example 

below, Course Identification has been highlighted and then in the Styles and Formatting 
task pane, HEADING 1 is selected (See Figure 5). 
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Figure 5:  Assigning Heading 1 to Highlighted Information. 

 
c. Left click the mouse in the Styles and Formatting task pane. This will change the 

formatting of the heading.  In our example, it changed Course Identification to COURSE 
IDENTIFICATION, bolded, and centered as has been formatted (See Figure 6). 
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Figure 6:  Heading1 Applied to Document. 

d. Continue this step until you have changed all major sections of your paper so that they 
are identified as headings.  

STEP 6:  Viewing the Major Headings with Document Map. 
 

a. Go to the View drop down menu. 
b. Select Document Map.  A task pane will be seen on the right hand side of your screen.  If 

the main headings are fully accessible, they will be listed (See Figure 7).  Each heading in 
the Document Map is fully linked to the same heading in the text.  This makes it easier 
for visually and cognitively impaired individuals to find a particular topic in the text 
without scrolling or searching the text. 
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Figure 7:  Document Map with Headings. 

 
c. A file WITHOUT accessible headings will look like Figure 8 in the right hand task pane 

once the Document Map is turned on. 
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Figure 8:  Document Map When No Headings Are Used. 

STEP 7:  Bullets and Numbering. 
 
When you cleared all the formatting in the beginning, you lost all formatting for numbering and 
bulleting.  For coherence and greater accessibility for cognitive and visual disabilities, number or 
bullet information based on the following criteria: 

a.  Use the number function for creating ordered lists where items are listed in order of 
importance or sequence.   

b.  Use the bullets function for lists of information that do not have a rank or order.   
 

STEP 8:  Creating Tables for Text in Columns. 
 
Special attention must be given to information you have put into columns.  Screen readers will 
have difficulty reading this information.  For great coherence and accessibility, you need to use 
table format.  This can be done by taking the following steps: 

a.  Select the columnar text (text in columns) that will be in the table. 
b.  Go to Table menu drop down, choose Convert. 
c.  Select Text to Table.   
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d.  You will need to identify how the text is currently separated.  Your choices will be tabs, 
paragraphs, commas, or others.  The most common will likely be tabs (see Figure 9).   

 

 
Figure 9:  Columnar Information Using Tabs. 

 
e.  In this case you would select Separate text at Tabs.  This function places a column for 

every Tab in the line of text and a row after every paragraph (Figure 10).   
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Figure 10:  Dialog Box for Converting Text to Table. 

 
f.  Notice, the number of columns reflects the number of tabs in the first line of the original 

table.  This will likely be too many tabs.  Identify the number of columns you want and 
input this number (Figure 11).  This step must be taken after you have selected Tabs as 
your separator. 

 

 
Figure 11:  Number of Columns Set to Number of Columns Wanted. 

 
g.  Your document should then have the columnar text in table format (Figure 12).  You may 

then want to adjust width of the columns. 
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Figure 12:  Document with Columnar Information Now in Table Form. 

 
h.  You need to have titles or labels for each of the columns (called a header row).  

Therefore, if your table goes across pages, there will be titles on the next page.  
Complete the following steps: 

1) With the cursor on the header row you wish to repeat (NOTE:  this must be the 
top row of your table), go to Table drop down menu,  

2) Select Heading Row Repeat. 
3) Once applied, the Heading Row Repeat function will repeat the heading row for 

table across separate pages of the document (Figure 13). 
 

 15



 
Figure 13:  Document Reformatted with Heading Row Repeated. 

STEP 9:  Creating and Attaching a Syllabus Styles and Formatting Template For 
Additional Syllabi Conversions. 
 
Once you have a syllabus formatted for accessibility, you can create a Styles and Formatting 
template for changing or creating additional syllabi with this pre-set formatting.  To make a 
Template: 

a.  Be sure to save your newly accessible syllabus document you just finished in Steps 1-8.   
b.  In that document, go to the File drop down menu. 
c.  Select Save As. 
d.  Change the File Name to Syllabus Template.   
e.  Change the Save as Type to Document Template (*.dot) (Figure 14). 
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Figure 14:  Save As Window for Template. 

 
f.  Open the syllabus you want to change or create.  If it is an existing document, you may 

want to follow Steps 1-3 to clear formatting and saving as a new document.  This will 
clean up the Styles and Formatting task pane.  It is not necessary that you do this. 

g.  In the document window, go to the Tools menu. 
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h.  Choose Templates and Add-ons.  Select Attach (See Figure 15). 

 
Figure 15:  Templates and Add-ons Dialog Box. 

 
i.   Choose the file Syllabus Template.dot as seen in Figure 16 (this is the template you 

creating previously in this step).   
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Figure 16:  Window Used to Select Syllabus Template. 

 
j.   Then click on the Open tab.   
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k.  Put a check in the box Automatically update document styles (See Figure 17).  

 

Figure 17:  Checking Automatically Update Document Styles in dialog box. 

 
l.   Then click on the OK tab.  The new style template will be attached to your document.  

This means that the Headings are formatted as they are in your template and can be 
applied to your document. 

Accessible Handouts  
 
Accessibility for handouts is not much different than for syllabi.  Existing documents and new 
documents need to have headings, numbered lists, and tables created with the table format.  You 
will want to follow STEPS 1-8.  This will work well with handouts that are text only, however, if 
you have handouts that contain pictures, figures, flowcharts, concept maps, etc., you will need to 
use Alternative-Text commonly referred to Alt-Tag.  

Images Accessible to Screen Readers (Pictures, Clip Art). 
 

a. Follow the Steps 1-3.  
b. Each image should be tagged using the Alternative Text function.   
c. Right click on the image.  
d. Click on the Format Picture tab.   
e. In the Format tab, click on the Web tab.  That will open an Alternative Text box where 

the image can be described in detail (See Figure 18).   
f. Close the description box.  You will not see any indication that there is an Alt-tag 

attached.  This will be read by screen readers only.   
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Figure 18:  Sample of Alternative Text Dialog Box. 

Captioning. 
 

a. Select the item needing a caption.  
b. Right click on the image.  
c. Select the Caption.  A Caption dialog box will appear. 
d. Type the caption.   
e. Select Ok. (Figure 20) 

 
Figure 19:  Dialog Box for Captioning. 
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Figure 20:  Document with Picture and Caption. 

Documents Using Auto Shape and Drawing for Concept Maps or Flowcharts. 
 
Objects drawn with boxes, ovals, and lines using the Autoshapes or Drawing functions cannot  
be read coherently by a screen reader.  To keep the image intact and make it accessible do the 
following: 

a. Create your document. 
b. Save as a .pdf file.  
c. Go to Insert drop down menu, select Object, in the Create New tab select Adobe Acrobat 

document, select Ok, and open the appropriate document.  The document will open in a 
new window.  Close the window and it will be in your original document (Figure 21). 

d. Describe the flowchart/concept map in detail in an Alt-tag (as described in the Images 
Accessible to Screen Readers (Pictures, Clip Art section above) (Figure 22). 
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Figure 21:  Sample Flowchart to be Alt-tagged. 
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Figure 22:  Flowchart Described in Alternative-Text in dialog box. 

Creating Hyperlinks 
 
Web addresses need to be active links in the document.  The default setting for MS Word is to 
automatically format an active link as you are typing the link.  If the web address is an active 
link, it automatically shows up in the document in a blue font and is underlined.  If this automatic 
format function is not enabled, then the web address will need to be activated.   
 
If the Web address does not automatically show up as an active link in the document, do the 
following:   

a.  Type in the web address in the document. 
b.  Then highlight the hyperlink.   
c.  Right click (or use CNTL K) to open the dialog box for inserting a hyperlink.  Select 

Hyperlink.   
d.  Make sure the address box shows the entire website address (see Figure 23).   
e.  In the Text to Display box, type a descriptive title.   
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Figure 23:  Hyperlink Dialog Box. 

 
f.  Select Screen Tips tab.  A new dialog box will open (see Figure 24). 
 

 
Figure 24:  Screen Tips Dialog Box. 

 
g.  Type the same descriptive title again.  Select OK to exit Screen Tips.   
h.  Then select OK to exit the Hyperlink dialog box. 
i.  The web address will be replaced with a descriptive title in blue font and underlined. 

 
If the Web address automatically shows up as an active link in the document, do the following:   

a.  Type in the web address in the document. 
b.  Point to the Web address and right click (or use CNTL K) to open the dialog box.  

Select Edit Hyperlink.   
c.  In the Text to Display box, type a descriptive title.   
d.  Select Screen Tips tab.  A new dialog box will open. 
e.  Type the same descriptive title again.  Select OK to exit Screen Tips.   
f.  Then select OK to exit the Hyperlink dialog box. 
g.  The web address will be replaced with a descriptive title in blue font and underlined. 
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Accessible PowerPoint Presentations 
 
Creating an accessible PowerPoint presentation is not much different from creating an accessible 
handout or syllabus.  The criteria are the same but formatting commands differ and the source of 
the templates differs as well.  For a full illustrated example of accessible PowerPoint 
presentations see the module in the EnAct Library website EnAct Sonoma AIM Library or 
directly at the Accessible PowerPoint website.  Another source of information is the website 
PowerPoint Magic which includes tutorials for creating accessible PowerPoint presentations.   
 
Accessibility criteria that are the same for all documents and described above:   

• Headings. 
• Numbered lists. 
• Bullets. 
• Tables. 
• Captions for objects and media links. 
• Special punctuation. 
• Concise phrasing and style. 
 

Accessibility criteria which are different for PowerPoint Presentations: 
• Slide layout.  Adopt a high contrast template.  Avoid red and green backgrounds or 

backgrounds with graphics that overlap the text.  Do not have animated or elaborate 
screen transitions.  

• Fonts. These should be between in Arial or Tahoma font with 28-40 font size.  Avoid 
red and green, or animated text. 

• Outline.  All text must be written in the Outline pane for it to be screen reader 
accessible.  Any text or graphics that do not show up in the Outline pane cannot be 
read by screen reading software.  Such material is inaccessible to the vision impaired 
unless it has been captioned or Alt tagged. 

• Notes section.  Use the Notes section to provide a complete transcript of the 
presentation. 

• Text Boxes.  Text boxes inserted manually are not accessible.  Use Slide Layout 
functions to insert information. 

 

Preparing a new accessible PowerPoint presentation:   
 

a.  Open a new PowerPoint document. 
b.  In the left task pane, select the Outline tab. 
c.  In the right task pane, under New menu, select From Design Template (see Figure 25). 
d.  Choose a high contrast template with very little or no graphic designs that overlap text 

space.  Any of these will have pre-formatted headings and fonts that are accessible. 
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Figure 25:  PowerPoint Design Template Task Pane. 

 
e.  Make color scheme adjustments using Color Schemes if necessary.  Dark colors with 

white letters or pastel colors with black letters works best (See Figure 26).   

 
Figure 26:  Sample of Color Choices to Aid Accessibility. 
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f.  Adjust slide layout to improve text coherence by selecting the right arrow at the top of 

the right task pane until the Slide Layout task pane is visible (see Figure 27). 
 

 
Figure 27:  Slide Layout Task Pane. 

 
g.  Begin typing in the text boxes and be sure anything typed shows up in the Outline pane. 
h.  Type a transcript of the presentation for this slide in the bottom pane where it says 

“Click to add notes” (see Figure 28). 
 

 28



 
Figure 28:  Example of Text in PowerPoint with Outline and Notes. 

 

Reformatting an Existing PowerPoint 
 
To prepare an accessible PowerPoint presentation from an existing PowerPoint file that was 
created using a blank slide and manually inserted text boxes (i.e., without a template):   
 

a.  Open the existing PowerPoint document. 
b.  Select the Outline tab in the left pane. 
c.  If the text does not show up in the Outline pane, then the document will have to be 

reformatted (see Figure 29). 
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Figure 29:  Slide Prepared Without a Design Template. 

 
d.  In the right task pane, under Slide Design menu, select Design Template. 
e.  Choose a high contrast template with very little or no graphic designs that overlap text 

space.  Any of these will have pre-formatted headings and fonts that are accessible.   
 

 
Figure 30:  PowerPoint Example with New Design Template Applied. 
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f.  Each slide where the text does not show up in the Outline pane will have to be replaced. 
g.  Insert a new slide after the first slide where the text is not visible in the Outline pane. 
h.  Copy the text from the text box in the old slide and paste it into the text area in the new 

slide.  Repeat this until all the text is placed in the new slide (see Figure 31). 
i.   Copy any notes in the Notes pane.   
j.   Delete the old slide. 

 
Figure 31:  New Slide Reformatted After Cut and Paste Procedure 

 

Creating a Table of Contents for HTML (for uploading documents to Websites). 
 
If the document is to be posted on a common Website, then the document needs to be saved as an 
HTML file as Web Page, Filtered. The accessibility features such as Document Map are 
functional only if the document is shared as a document file.  To create easier navigation in an 
HTML file, create a Table of Contents prior to saving the file as a web page.  This will create 
links between the Table of Contents listings and the document.   

a.  Open the final draft of the document.  Place curser at the point you want the Table of 
Contents located.  

b.  Select the Insert menu. 
c.  Select Reference. 
d.  Select Index/Tables. 
e.  Select Table of Contents tab. 
f.  Be sure the Use hyperlinks in stead of page numbers box is check (this is the default) 

(Figure 32). 
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g.  Note:  Table of Contents does not automatically update should further changes be made 
in the headings.  To make changes after creating Table of Contents, redo the steps listed 
above. 

h.  After all changes have been made, select File. Select Save As. In the Save as type, select 
Web Page, Filtered, then Save. 

 

 
Figure 32: Dialog Box for Table of Contents 
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